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Introduction 

This Job Aid provides information about the changes to the Child Protective Record Summary 
(CPRS) and, more specifically, to the Progress Notes functions in CONNECTIONS that are 
being introduced with Build 16. 

 

Progress Notes 

Progress Notes are kept on all child protective investigations and open child welfare services 
cases. They provide documentation of all caseworker activities associated with Child Protective 
Services investigations and provision of services. Progress Notes document the timely activities 
of casework staff and the information acquired during these activities. They also capture the 
decision-making and actions by caseworkers and other staff or service providers to provide for 
the safety, permanency and well being of children and to reduce the risk of future abuse or 
maltreatment. They include all contacts and attempted contacts made by the caseworkers or 
other district or agency staff assigned to the case. A listing of the types of contacts to be 
recorded in Progress Notes can be found in “Appendix A: Information to be Recorded in 
Progress Notes” on page 27. 

The nature of Progress Notes will not change with Build 16, i.e., what should be recorded and 
when will not change. Progress Notes begin on the case initiation date or upon receipt of a 
report of suspected abuse or maltreatment for child protective service cases, and are continued 
until the case is closed to all child welfare services. Progress Notes are to be recorded as soon 
as possible after the event occurred or the information is received to ensure an accurate, 
contemporaneous account of the event. 

There are several key changes to Progress Notes that will occur with the implementation of 
Build 16: 

• Progress Notes will be searchable. 

• Progress Notes will be comprised of data fields (e.g., Type, Method of Contact and 
Location of Contact) and a narrative that provides both caseworkers and supervisors 
with a uniform and consistent way of recording notes. These fields are system-
populated, required, conditionally required or optional. For a complete listing of the data 
fields, see page 8. 

• Progress Notes can be saved in Draft status or in Final status, which freezes the notes. 
Those notes that are saved in Draft status will freeze after 15 calendar days. Frozen 
notes cannot be modified. 

• The narrative field will have the text tool control, which provides workers with some 
Microsoft Word-like functionality (e.g., spell check). For more information about this 
feature, see page 17. 

• The Local Notes, Supportive District Notes and the Supervisory Review and 
Comments tabs in the CPRS will no longer be available for implemented stages. 
Instead, supervisors and Secondary workers from supportive districts will all record 
Progress Notes within the Progress Notes tab. For all of the stages created prior to 
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Build 16 implementation, the above-mentioned tabs will still display in the CPRS and 
they will be available for viewing historical CPRS events. 

• To manage Progress Notes with greater ease, workers will be able to copy notes from 
one Investigation stage to another within the same case. 

• The Local Protocol tab will provide workers with a district-specific template for 
recording information required by their local district’s policy and procedures. This tab will 
enable only for local districts that have submitted a template; for all other districts, this 
tab will be disabled. For more information, see “Local Protocol Tab” on page 6. 

Until the implementation of Build 18, Progress Notes will continue to exist in more than one 
location for Child Protective Services cases that also receive other child welfare services 
(i.e., Foster Care, Adoption, Preventive Services). Child welfare workers who maintain Uniform 
Case Records (UCRs) for families will continue to record Progress Notes outside 
CONNECTIONS, while CPS workers will be recording Progress Notes in CONNECTIONS. At 
times there may be some overlap in the material recorded by each worker or some question 
regarding in which part of the “record” (i.e., in CONNECTIONS or externally) a Progress Note 
should be recorded. A good general principle to keep in mind is that each worker should 
maintain Progress Notes on all relevant case activities that s/he is directly involved in or that 
directly impact the aspect of the case for which the worker is responsible. When workers are 
uncertain about where material should be recorded, they should consult their own local 
procedures and supervisors. 

 
Security 
A worker’s ability to access, view and maintain Progress Notes is dependent on a number of 
factors. There are three distinct security rights that workers need in order to work with Progress 
Notes. The worker’s role in the stage and his/her need to complete certain tasks dictates the 
rights that are assigned to that worker. 

In order to create notes a worker must be: 

• assigned a role in the stage;  

• within the assigned worker’s unit hierarchy;  

• assigned the “ENTER PROG NOTE” Business Function; or 

• assigned a Progress Notes Task To-Do. 
 

In order to modify notes a worker must be: 

• the Progress Note’s Author; or 

• the Progress Note’s Entered By person. 
 

If the author has been identified as “Other,” then only the Entered By person can modify a note. 

In order to view notes a worker must: 

• have access to the Child Protective Record Summary (CPRS). 
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There are several security rights that will be implemented with Build 16.  

Pre-Build 16  Implemented Build 16 
• Supervisors can modify their workers’ 

Progress Notes. 

• Workers in the same Local District can 
modify Progress Notes (provided they 
had a role in the stage). 

• Caseworkers can modify their 
supervisor’s comments in the 
Supervisory Review and Comments 
tab. 

• Supervisors will not be able to modify 
their workers’ Progress Notes. 

• Only the Author or Entered By person 
will be able to modify notes. 
Modifications can be made only while 
the note is in Draft status. Notes in 
Final status cannot be modified, but 
addenda can be appended to them. 

• Caseworkers cannot modify their 
supervisor’s comments. 

There are times when someone other than a caseworker or supervisor, such as clerical staff, 
will record Progress Notes in CONNECTIONS. Those workers will be given the ENTER PROG 
NOTE Business Function, which enables the worker to create and/or modify Progress Notes for 
a stage. Workers with this Business Function will access the Progress Notes from the Case 
Summary window; only the Progress Notes tab will be accessible in the CPRS. If that same 
type of worker receives a user-generated Task To-Do to complete a Progress Note, that worker 
will have access only to the Progress Notes Detail window and Progress Notes tab. All other 
tabs will be disabled. 

At times, stage assignments may change during the course of an investigation. For example, 
Worker “A” unassigns Worker “B” (who is the author of notes in draft status) from the stage. 
When Worker “A” clicks on the Save button, the following warning displays: 

“You are about to remove a worker who has 
DRAFT Progress Notes in this stage. Continue?” 

• Clicking on the Yes button will save the reassignment. The Author of the note will no 
longer be able to access the notes. If the Entered By person is a clerical worker, s/he will 
still be able to modify notes. 

• Clicking on the No button will not save the reassignment and the worker will be returned 
to the Assign window. 
 

Accessing Progress Notes to Create or Modify a Note 
There are three primary ways to access Progress Notes to create or modify a note:  

CPRS Task • From the Task List for an Investigation stage, select the Child 
Protective Record Summary task and click on the Detail… 
button. 

• Click on the Progress Notes tab. The Progress Notes Detail 
window displays. 
 

Task To-Do • From the Case To-Do List or Staff To-Do List, select the 
Progress Notes Task To-Do and click on the Navigate… button. 
The Progress Notes Detail window displays. 
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Case 
Summary 
Window 

• From the Case Summary window, click on the Options menu 
and select the Enter Progress Notes command. The Progress 
Notes Detail window displays. 

 

Accessing Progress Notes to View Notes 
There are four primary ways to access Progress Notes to view notes for open stages. 

CPRS Event • From the Event List, select a CPRS event and click on the 
Detail… button. The CPRS displays. 

• Click on the Progress Notes tab. 

 

CPRS Task • From the Task List for an Investigation stage, select the Child 
Protective Record Summary task and click on the Detail… 
button. 

• Click on the Progress Notes tab. The Progress Notes Detail 
window displays. 

 

Task To-Do • From the Case To-Do List or Staff To-Do List, select the 
Progress Notes Task To-Do and click on the Navigate… button. 
A blank Progress Notes Detail window displays. 

• Click on the View Existing Notes button. 

 

Case 
Summary 
Window 

• From the Case Summary window, click on the Options menu 
and select the Enter Progress Notes command. The Progress 
Notes Detail window displays. 

• Click on the View Existing Notes button. 
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Local Protocol Tab 
A Local Protocol tab has been created in place of the Local Notes tab for those districts that 
have submitted a district-specific template for recording additional investigation information. This 
tab will only be available for those districts that submit a template (ACS, Delaware, Erie, Putnam 
and Schoharie). If the Primary worker’s district is not using a template, the Secondary worker 
will not be able to use a template either. The Primary worker’s district takes precedence over 
the Secondary worker’s district. See the table below for more information about the availability 
of the Local Protocol Tab. 

Districts using the Local Protocol template will still be required to complete Progress Notes 
using the Progress Notes tab. The Local Protocol templates will only contain additional 
information that isn’t included as part of the narrative or data fields on the Progress Notes tab 
and that isn’t included anywhere else in CONNECTIONS. For example, ACS caseworkers will 
use the Casework Practice Recording Template (CPRT) available on the Local Protocol tab to 
record information such as domestic violence screening. 

When the Local Protocol tab is accessed for the first time, the Local Protocol template will 
display. If the worker remains on the tab after the initial save, s/he will click on the Edit 
Narrative button in the middle of the tab to reopen the document for viewing or editing. If the 
worker leaves the Local Protocol tab or closes and reopens the CPRS, the Local Protocol 
narrative will display. 

The table below illustrates how the availability of the Local Protocol tab (and any information it 
may contain) is affected when a stage is reassigned from one local district to another. In the 
table, District A is the originally assigned (“previous”) district and District B is the newly assigned 
(“new”) district for the stage. 

District B 

 

HAS a Local Protocol 
Template 

Does NOT Have a Local 
Protocol Template 

HAS a Local 
Protocol Template 

(information 
recorded) 

District A’s template will 
continue to be used for the 
life of the investigation. 

District B will be able to access 
the Local Protocol tab in view-
only mode to view the formatted 
information recorded by District A. 

D
is

tr
ic

t A
 

Does NOT Have a 
Local Protocol 

Template 

The Local Protocol tab will 
be enabled and will contain 
District B’s Local Protocol 
template. 

The Local Protocol tab will be 
disabled for both districts, since 
no Local Protocol template exists. 
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The Progress Notes Tab 
 

Progress Notes Detail Window 
The creation of a new note is completed via the Progress Notes Detail window. Modifying, 
duplicating, saving and printing Progress Notes can also be completed on this window. The 
window is separated into two main parts:  

• Workers use the data fields to record contact-specific data, such as who was contacted, 
when and where the contact was made. Some data fields are system-populated, others 
are required, and still others are optional. 

• Workers use the narrative to record clear, descriptive and factual information about the 
events, conversations and resolutions that took place during the contact. Impressions or 
opinions of the worker and relevant information to support these can also be expressed 
and should be labeled as such, as well as the participation and perceptions of family 
members in the planning for services. The narrative has the text tool control feature, 
which enables the worker to use certain Microsoft Word-like formatting and functionality. 
See page 17 for a complete listing of the features that are available. 

The Type, Method of Contact and Author fields are required for all notes. Based on the 
selections made for Type and Method of Contact:  

• some fields will be required; 

• some fields will be enabled or disabled; and 

• some of the choices in the drop-down lists may change. 

For a listing of types of contacts that are recorded in CONNECTIONS, see “Appendix A: 
Information to be Recorded in Progress Notes” on page 27. 
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The following fields display on the Progress Notes Detail window: 

Event Date The date the contact took place; this is a required field for any note 
(expect those with a Type of “Summary”). Clicking in the check box 
will populate this field with a check mark. In order to record a date, 
this check box must be selected. The Event Date field will default 
with today’s date. If you’d like to change that date to a date in the 
past, click on the drop-down arrow and select a date from the 
calendar. 

Time  The time the contact occurred in hours and minutes (with AM and 
PM [e.g., 1:00 PM], or military time [e.g., 13:00]). 

Type Indicates the type of contact made. This is a required field selected 
by the worker. One or more Type(s) can be selected for a note, but 
at least one type must be selected. If more than one is chosen, 
“multiple” displays in the field. See the table on page 14 for a list of 
possible types.  

Contacts here refer to any contact 
related to casework activity such as 

collaterals and court. 
 

Method of Contact Describes how or by what means the contact was made (e.g., Face 
to Face, Phone). This field is required and contains a drop-down list 
with options. Methods are available based on the Type of contact the 
worker selects. See page 14 for a list of possible methods and 
situations when certain choices are available. 

Unannounced Visit 
(check box) 

This check box indicates that contact was made without a 
prearranged appointment. This check box is enabled only when the 
Type of contact is “Attempted Casework Contact” or “Casework 
Contact.” 

Location of Contact Identifies where the contact took place. The worker selects the 
location from a drop-down list. For a list of possible choices, see 
page 14. There are times when this field is required, enabled or 
disabled, depending on the responses that were selected in other 
fields. See “Appendix B: Progress Notes Data Fields Edit Matrix” on 
page 29 for details. 

Family 
Participant/Focus 

This field contains the list of persons identified on the Person List 
that are part of any concurrently open stages. It is system-populated 
and cannot be modified. Two check boxes within this field can be 
selected: 

• The Family Participant (FP) check box allows the worker to 
indicate which family participant(s) were present at the 
contact. There are times when this check box is required, 
enabled or disabled, depending on the responses that were 
selected in other fields. See “Appendix B: Progress Notes 
Data Fields Edit Matrix” on page 29 for details. 
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• The Focus check box allows the worker to indicate which 
individual(s) from the Person List are the focus of a particular 
contact. There are times when this check box is required, 
enabled or disabled depending on the responses that were 
selected in other fields. See “Appendix B: Progress Notes 
Data Fields Edit Matrix” on page 29 for details. 

Family Participants are any family members who are present at the 
contact (e.g., a phone call from the biological father or a family 
visitation with the mother); the Focus refers to the individual(s) about 
whom the contact occurred. For example, if the caseworker, teacher 
and mother met to discuss the child’s Independent Education Plan 
(IEP), the mother would be the Family Participant and the child 
would be the Focus (even though he was not present), because the 
purpose of the meeting was to discuss his IEP. The teacher would 
be included as an Other Participant. 

Other Participant This field contains a list (by category, not name) of others outside the 
Person List for the case who may be participants or contacts 
involved in the case. One or more can be selected from the Other 
Participant window for each note. If more than one is selected, 
“Multiple” displays in the field. For a list of possible choices, see 
page 14. There are certain situations when this field is required, 
enabled or disabled; “Appendix B: Progress Notes Data Fields Edit 
Matrix” on page 29 identifies these circumstances. 

Author This required field indicates the person who made the contact or 
directly acquired the information being written about. The list of 
choices will be comprised of the assigned worker(s) in the 
district/agency, anyone assigned in or out in their unit and “Other.” 
When the Entered By worker is an assigned worker, the Author field 
will default to the name of that worker. This default can be changed. 

Entered By This field contains the system-populated name, based on the Person 
ID of the worker recording the note in CONNECTIONS. 

Dist./Agy This system-populated field indicates the code of the District/Agency 
of the worker in the Entered By field.  

Entry Date This reflects the date the window is first accessed. This date is 
system-filled and cannot be modified. 

Purpose The purpose or reason of the contact. (See page 14 for a drop-down 
list of possible choices and for direction regarding when some of 
these choices will be available.) More than one Purpose can be 
selected for a note. If more than one is selected, “multiple” displays 
in the field. See the table on page 29 for details regarding when this 
field is enabled or disabled. 

Progress Notes 
Narrative 

In this required field, the author or Entered By person documents all 
of the details pertaining to the note. See page 7 details. 

 



Page 10 CONNECTIONS – System Build 16 Progress Notes Job Aid - 09/24/2003 

The following buttons display at the bottom of the Progress Notes Detail window: 

Copy Note Clicking on this button initiates the action of copying a saved note. 
This button is disabled when the Progress Notes Detail window is 
accessed in modify mode and changes are made. The button will 
enable when:  

• a note is selected on the Progress Notes tab or displayed in 
the Progress Notes Detail window; 

• the open “copied to” Investigation stage has the same Case 
ID as the “copied from” Investigation stage; and  

• both the “copied from” and the “copied to” Investigation 
stages are implemented with Build 16. 

For more information, see “Copying Progress Notes” on page 25. 

New Note This button creates a new note. Clicking on this button will clear the 
existing fields to allow the worker to create a new note without 
having to close the Progress Notes Detail window. 

The New Note button on the Progress Notes Detail window will be 
disabled, except when viewing an existing note, at which time the 
button will be enabled. 

View Existing Notes This button enables when the Progress Notes Detail window is 
accessed but changes have not been made to a note. Once changes 
have been made, this button disables. Clicking on this button 
displays the Progress Notes tab; a note can then be selected to 
view. 

Save as Draft This button enables when the worker creates a new note and 
records all required fields, or when the worker modifies data within 
an existing “Draft” note and all of the required fields are populated. 
Clicking on this button saves the note in draft status. Notes are in 
draft status for 15 calendar days. (See “Saving Progress Notes” on 
page 19.) This button will enable even if the Date has not been 
recorded (but all other required fields have been recorded); however, 
if you click on the Save as Draft button under these circumstances, 
the following message will display: “Date is required.” 

Save as Final This button enables when the worker creates a new note and 
records all of the required fields, or when the worker modifies data 
within an existing “Draft” note and all of the required fields are 
populated. Clicking on this button saves the note as “Final,” which 
“freezes” the note. None of the entries can be modified; instead 
addenda can be added. (See “Adding an Addendum to a Frozen 
Note” on page 23.) 

Cancel Clicking on this button cancels the creation of the note. Unsaved 
information will be discarded and the Progress Notes Detail window 
will close. This button enables only if unsaved changes exist. 



 

CONNECTIONS – System Build 16 Progress Notes Job Aid - 09/24/2003 Page 11 

If the Cancel button is not enabled, 
use the View Existing Notes button 
to return to the Progress Notes tab. 

 
 

Progress Notes Tab 

 
The Progress Notes tab is comprised of three sections: the Search Progress Notes filter fields 
at the top of the tab, the search results grid in the middle, and buttons along the bottom. 

The fields at the top of the window are the search filters that can be selected. Anywhere 
between one and all of the search filters can be selected for a search list. (See “Filtering 
Progress Notes” on page 20 of this Job Aid.) These filters comprise the bulk of the columns of 
the search results grid located in the middle of the tab: 

From Event Date and 
To Event Date 

Filters within the range of dates selected in the search criteria. To 
search for one specific event date, enter the same date in both 
fields. To search on an open-ended date, enter the date in the 
From Event Date field and leave the To Event Date field blank. 
All Progress Notes from that date forward will return in the 
search. Conversely, the same procedure can be performed with 
the To Event Date; all of the notes from that date back will return 
in the search. 

Type Filters the search results by type of contact as selected from the 
Type window. For a list of possible Type choices, see page 14. 
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Author Filters by the author of the note. The worker will select from a 
drop-down list populated with the name(s) of anyone who has 
already authored a note in the stage. 

Family Part. 
(participant) 

Filters the search results by family participant from the drop-down 
list consisting of persons in the stage. 

Method Filters the results by the Method of contact from a drop-down list 
containing possible methods. See page 14 for a list of possible 
methods. 

Entered By Filters the search list by Entered By person; the drop-down list is 
comprised of the workers who have recorded notes. 

Other Part. 
(participant) 

Filters the search (by category, not name) of others outside the 
Person List for the case who may be participants or contacts 
involved in the case. Options are selected from a drop-down list. 
For a list of possible choices, see the table on page 14.  

Purpose Filters the results by the Purpose of the contact. For a list of 
possible purposes in the drop-down list, see page 14.  

District/Agency Filters the search results by the code of the District/Agency of the 
Entered By worker. 

Focus Filters the results by the person who is the focus of the note. 
Choices are selected from a drop-down list comprised of possible 
focuses. 

Location Filters the results by the Location of the contact. For a list of 
possible locations in the drop-down list, see page 14. 

The search results grid displays many of the fields listed above, as well as fields on the 
Progress Notes Detail window. (Many of these fields are listed on both the Progress Notes tab 
and the Progress Notes Detail window.) For a complete list, see the field descriptions above and 
on page 8. There are three filters that do not display on either the Progress Notes Detail window 
or the Progress Notes tab in the search filters, but they do display in the search results grid: 

• Note Status indicates whether the note is in “Final” or 
“Draft” status. 

• Addendum indicates whether or not an addendum has 
been added to the note. (For more information, see 
“Adding an Addendum to a Frozen Note” on page 23.) 

• Copied From indicates the stage from which the note was copied. This never prints on 
any of the Progress Notes Data Reports. (For more information see “Copying Progress 
Notes” on page 25.) 

 

 

In addition, the following functionality is available 
on the Options menu: 

• Add Addendum 
• Delete Draft Note 
• Create To Do 

 
You may need to use the scroll 
bar to see all of the columns on 

the search results grid. 



 

CONNECTIONS – System Build 16 Progress Notes Job Aid - 09/24/2003 Page 13 

 

Several buttons display on the Progress Notes tab: 

Refresh List Refreshes the Progress Notes search list to the default display list of 
notes and removes the filters or sorts. Once filters or non-default sorts 
have been selected, this button enables. 

Search Initiates the Progress Notes search after search criteria have been 
selected. 

Sort Opens the Sort window, where up to three sort criteria can be selected at 
a time. See “Sorting Progress Notes” on page 21 for more information.  

View Note Once a specific note is selected, clicking on this button allows the worker 
to view the details of the selected note. 

New Note Opens a blank Progress Notes Detail window. 

Edit Note Begins the process of modifying a note that has been selected from the 
search results list. This can only be done with notes in “Draft” status. 

Copy Note Copies a note that has been selected from the search results list. The 
button will enable when:  

• a note is selected on the Progress Notes tab or displayed in the 
Progress Notes Detail window; 

• an open “copied to” Investigation stage has the same Case ID as 
the “copied from” Investigation stage; and  

• both the “copied from” and the “copied to” Investigation stages are 
implemented with Build 16. 

Select All Selects all of the Progress Notes in the results list; allows all of the notes 
to be printed at once. 

Print Note(s) Opens the Print Notes window for the selected note(s). Notes can be 
printed to include only the data fields (which generates the Progress 
Notes Data Report) or both the data fields and narrative. Clicking on the 
OK button on the Print Notes window displays the selected notes in print 
preview mode. 

 
Several fields on the Progress Notes tab and Progress Notes Detail window contain drop-down 
lists that are common across all stages:  

• Type • Method • Location 

• Other Participant  • Purpose  
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The table below contains all possible options for a particular field. The choices that are available 
for Location, Purpose and Other Participant depend on what the worker selects for Type and 
Method. These situations are described below the table. For further clarification as to when to 
use certain values, consult your local district’s procedures, guidelines and your supervisor. 

Type Method Location Other Participant Purpose 
Attempted Family 
Visitation 

Mail Congregate Care 
Facility 

Indian Tribe/Council Pre-Adoption Activities 

Attempted 
Casework Contact 

Face to 
Face 

Adoptive Home Community Resource Adoption Activities 

Attempted Sibling 
Visitation 

Fax Court Juvenile Detention Aftercare Services 

Case Conference Phone Day Care Law Enforcement Assessment 

Casework Contact  Email Foster Home Legal/Attorney Counseling 

Collateral Contact  Other Hospital/Health 
Facility 

Medical Child Preparation 

Court   LDSS Office/Field 
Office 

Mental Health Crisis Intervention 

Family Visitation   AMH Facility Probation Educational Planning 

Sibling Visitation  OMRDD Facility Service Provider Employment/Training 

Summary  Service Provider/ 
Contract Agency 

School Staff Family Planning 

Supervisor/ 
Managerial 
Review 

 Precinct/Law 
Enforcement Office 

Alcohol/Other Drug 
Service 

Housing 

  Parent’s Home Volunteer/Mentor Independent Living 
Services 

  Prison Foster/Adoptive Parent Coordinate/Monitor 

  Public Location Relative Case Planning 

  Relative’s Home Primary Resource 
Person 

Parent Training 

  School Caseworker Placement 

  Shelter-Domestic 
Violence 

Supervisor Investigation 

  Shelter-Homeless Case Manager Medical 

  Child Advocacy 
Center 

Case Planner Review Notes 

  Case Address Reporter/Source Review Case 

Continued on next page 
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Type Method Location Other Participant Purpose 
(continued from previous page) 

  Other Congregate Care Staff 24 Hour 

   Administrator Initial * 

   Day Care Provider 48 Hour * 

   District/Agency Staff 5 Day * 

   Other 10 Day * 

    25 Day * 

    30 Day * 

    50 Day * 

    55 Day * 

* See the note below regarding these purposes. 

Some choices will be available only under specific circumstances: 

• Review Note and Review Case will only be available as choices when the Type is 
“Supervisor/Managerial Review.” 

• 24 Hour will be available as a choice for Purpose when the Type is “Casework Contact” 
or “Attempted Casework Contact.” 

HIGHER-LEVEL EDITS: 
In addition, there are higher-level edits and 

values that some districts may request. They are 
additional requirements that will be in place when 
the Primary worker in the stage is a member of a 
district which has requested higher-level edits. 

These edits will affect the choices that are 
available to the worker, depending on responses 

made to specific fields: 
 

• 48 Hour will be available as a choice for Purpose 
when the Type is Casework Contact or Attempted 
Casework Contact. 

• Review Note, Review Case, Initial, 48 Hour, 5 Day, 
10 Day, 25 Day, 30 Day, 50 Day and 55 Day will only 
be available as choices for Purpose when the Type is 
Supervisor/Managerial Review. 
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Creating a New Progress Note 
Notes are created throughout the course of the Investigation by workers in primary districts, 
workers in supportive districts, and supervisors. New notes are created from the Progress Notes 
Detail window and are used to collect data specific to a note or casework contact, such as who 
was contacted, when and where the contact was made and what occurred during the contact.  

Upon Entering the Progress Notes Detail window, the following data fields are… 

system populated and 
can’t be changed: 

enabled and can be recorded 
in any order: 

• Name(s) in Family 
Participant/Focus  

• Entered By 

• Dist./Agy. 

• Entry Date 

• Event Date 

• Type of Contact 

• Progress Note narrative 

• Author 

 
The Type, Method of Contact and Author fields are required 
for any note. Depending on the selections made for Type and 
Method of Contact, other fields may also be required. See the 
table on page 29 for details on which fields are required and 
when.  

The Type of contact, such as “Attempted Casework Contact,” 
is recorded in the Type field. Clicking on the Type button 
displays the Type window with a listing of all the possible types 
of contact. There are two buttons at the bottom of this window, 
OK and Cancel. Upon entering the window, the OK button is 
disabled and the Cancel button is enabled. One or more valid 
Types may be selected by clicking on the corresponding check 
box. Once the type(s) are recorded, the OK button and the Method of Contact field enable. 

 

 
For supervisors, 

“Supervisor/Managerial Review” 
in the Type field is available to 
document supervisory activities 
related to an investigation. This 
is used in place of the pre-Build 
16 Supervisory Review and 

Comments tab. 
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The Method of Contact field contains a drop-down list in 
which the options available are dependent on what is recorded 
in the Type field. Once these two components are recorded, 
additional fields will be required, conditionally required, enabled 
or disabled. See “Appendix B: Progress Notes Data Fields Edit 
Matrix” on page 29 regarding required fields. 

The person recording the new note must identify the Author of 
the note from the drop-down list in the Author field. The 
options in this list will be: assigned worker(s) in the 
district/agency; anyone assigned in or out of the Author’s unit; 
and “Other.” When the Entered By person is an assigned 
worker, the Author field will default to the name of that worker. 
This value is modifiable.  

The Narrative field, with a limit of 100 pages per note, will be 
blank and can be recorded at any time. The narrative has 
some of the same functionality as Microsoft Word: print, 
preview, Spell Check, copy, paste, cut, bold, italics, underline, 
align left, align right, center, justify, numbering, bullets and 
zoom.  

When creating a new note, the Copy Note, New Note and 
View Existing Note buttons are disabled. Once all required 
fields and the narrative are complete, the Save as Draft and 
Save as Final buttons enable on the Progress Notes Detail 
window. 

If the Date is not recorded, the Save as Draft and Save as 
Final buttons will still enable (provided all other required fields 
and the narrative have been completed), but if the worker 
clicks on either of these buttons, the following message will 
display: 

“Date is required.” 

The Cancel button enables once the worker starts recording a new note. 

 
For the data fields on the 

Progress Notes Detail window, 
the Primary worker’s district 
edits and data values take 

precedence over the Secondary 
worker’s district edits. 

Therefore, if the Primary worker 
is in a district that has the 

standard-level edits and data 
values, and the Secondary 

worker is in a district that has 
requested the higher-level edits 
and data values (ACS only), the 
Primary worker’s standard-level 

edits and data values take 
precedence over the Secondary 

worker’s district edits, 
regardless of which district has 
the higher level edits and data 
values. If the Primary worker’s 
district is in ACS, the higher-

level edits and data values take 
precedence and the Secondary 

district will have to follow the 
higher-level edits. The higher-

level edits will display; however, 
the Secondary district may opt 

to select only the standard level 
of values.  
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Step-by-Step: 
Creating a Progress Note 

1 From a blank Progress Notes Detail window, record 
the data in the required and optional fields. (For 
methods of accessing the Progress Notes Detail 
window, see page 4.) 

2 Record comments in the Narrative field. 

3 Click on the Save as Draft button. 
The note saves in draft status for 15 calendar days. 
The Progress Notes tab displays. 
—OR— 
Click on the Save as Final button. 
The note freezes immediately. The Progress Notes 
tab displays. 

 

While creating a note, if the worker attempts to modify the Type of contact, the following 
message displays: 

“Changing the Type of contact will clear all user entered data 
with the exception of the narrative. Do you wish to continue?” 

• Clicking on the Yes button will discard the data already recorded, with the exception of 
the narrative.  

• Clicking on the No button will cancel the action without clearing the data fields.  

In both cases, the worker will be returned to the Progress Notes Detail window. If the Type is 
changed, fields that were cleared by CONNECTIONS will have to be re-recorded. 

While creating a note, if the worker attempts to modify an existing value for Method of Contact, 
the following message displays: 

“Changing the Method will clear any user entered data with the exception 
of the Narrative and Type of Contact. Do you wish to continue?” 

• Clicking on the Yes button will clear all recorded data fields (except for the Type field 
and the narrative) on the Progress Notes Detail window. 

• Clicking on the No button will cancel the action without clearing any of the data fields.  

In both situations, the worker will be returned to the Progress Notes Detail window. If the 
Method of Contact is changed, the fields that were cleared by CONNECTIONS will have to be 
re-recorded. 

“Appendix B: Progress Notes Data Fields Edit Matrix” on page 29 provides an in-depth look at 
the fields that are enabled, disabled or required depending on the selection of other fields. The 
columns indicate the fields on the Progress Notes Detail window; the rows indicate the possible 
responses to Type and Method that affect whether the field is enabled, disabled or required. 

 
To allow for modifications to a 
note during the draft period, 

save the note as “Draft.” If no 
modifications are necessary, 

save the note as “Final.”  

Remember that once a note is 
saved as “Final,” no 

modifications can be made; 
only addenda can be made 

to the note. 
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Saving Progress Notes 
There are two ways to save a note: as “Draft” and as “Final.” 

Saving as “Draft” Notes can be saved in Draft status for 15 calendar days. 
Modifications can be made during that 15-calendar-day period. At 
the end of the 15-calendar-day period, the note automatically saves 
as “Final.” Upon saving a note in Draft status, the newly saved note 
displays in the search results list on the Progress Notes tab. The 
Note Status column populates with “Draft.”  

Saving as “Final” Once the 15-calendar-day draft period is complete, notes 
automatically save as “Final.” Notes can also be saved in Final 
status by the Entered By person by clicking on the Save as Final 
button. Upon saving a note in Final status, the newly saved note 
displays in the search results list on the Progress Notes tab. The 
Note Status column populates with “Final.” A note saved as “Final” 
freezes; modifications can no longer be made to the note. Only an 
addendum can be appended to the end of the frozen note. The 
worker also has the option to save a note as “Final” at any time 
during the 15-calendar-day Draft period. Once this is done, the note 
is frozen and cannot be modified. Upon closing a stage, 
CONNECTIONS will convert any notes currently in Draft status to 
Final status.  
 

As part of the nightly batch update, CONNECTIONS identifies 
any notes that have been in Draft status for 15 calendar days 
and changes the status to “Final.” Each time a note is saved, 
CONNECTIONS keeps an historical record of when notes are 
saved and by whom. 

To view notes that have already been recorded, return to the 
Progress Notes tab. 

Searching Progress Notes  
Workers and supervisors may find it useful to search for notes 
(e.g., a worker may want to view notes that have been already recorded in CONNECTIONS to 
review what has occurred throughout course of the investigation; a supervisor may want to view 
previously recorded notes especially when approving work). A Progress Notes search is 
conducted through the Progress Notes tab.  

There are two ways to begin a search: 

• The Progress Notes tab can be accessed in view-only mode through the CPRS event 
on the Event List. 

• The worker can select the Child Protective Record Summary task from the Task List 
(or the Enter Progress Notes command from the Options menu), then click on the 
View Existing Notes button on the Progress Notes Detail window.  

By default, when the Progress Notes tab is accessed, the search results grid displays all of the 
Progress Notes for the stage. The notes display with the most recent notes at the top of the list. 

A worker may want to view notes that contain certain criteria. For example, a caseworker may 
want to display only the notes in which a particular family member is the focus. A Progress 

 
All Progress Notes must be 

saved as “Final” prior to 
providing them to any entity 

legally authorized to receive the 
record (e.g., family court, 

district attorney). 
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Notes search is necessary to display only those notes with the focus on that family member. 
Searching retrieves a list of existing Progress Notes for a stage.  

Once a note has been selected, the View Note, Copy Note and Print Note(s) buttons enable. 
If the selected note is in Draft status, the Edit Note button also enables. The Search button 
enables when search criteria have been selected.  

 

Step-by-Step: 
Searching for Progress Notes 

1 Click on the Progress Notes tab in the CPRS. 
A blank Progress Notes Detail window displays. 

2 Click on the View Existing Notes button. 
The Progress Notes tab displays with the list of notes that have been saved for that 
stage. 

Filtering Progress Notes 
Within the Progress Notes search, if a large number of notes display in the search results list, 
the worker may want to narrow that number by applying filters to the list. The following filters are 
available: 

• From Event Date 

• To Event Date 

• Type 

• Author 

• Family Part.
(participant) 

• Method 

• Entered By 

• Other Part. 
(participant) 

• Purpose 

• District/Agency

• Focus 

• Location 

 

After the filters are selected, the Search button enables and the search is restricted to only the 
Progress Notes that fall into the selected parameters. 

 

Step-by-Step: 
Filtering Progress Notes 

1 From the Progress Notes Detail window, click on 
the View Existing Notes button. 
The Progress Notes tab displays. 

2 Select the filters you wish to apply to the search by 
selecting from the drop-down lists and/or entering 
data in the fields. 

3 Click on the Search button to apply the filters to the 
search. 
The Progress Notes tab displays with the filtered results list. 
 

 
Once filtering has been set, 
clicking on the Refresh List 

button displays the most current 
list of notes with the filters 

removed. 
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Sorting Progress Notes 
Once a search has been conducted, Progress Notes are sorted by default in descending order 
by Event Date and Time. Along with the default sort, there are two methods available for sorting 
the notes: 

• Within the search results list, click on the desired column heading by which you want to 
sort the notes. The list displays in ascending order.  

• Click on the Sort button to open the Sort Notes window. Up to three sort criteria can be 
selected. Each sort can also be ordered in ascending or descending order within the 
Sort Notes window. 

 
Progress Notes can be sorted by any column heading on the grid. The list of column headings 
(on page 6 in the “Progress Notes Tab” section) describes the column headings two ways: in 
terms of filters for searching and in terms of fields within the Progress Notes Detail window. 
Sorting also provides the ability to select the Note Status, Addendum and Copied From fields, 
which are included in the search results grid, but not included on the Progress Notes Detail 
window. 
 

 

Step-by-Step: 
Sorting Progress Notes 

1 To sort the existing columns in ascending order, 
from the Progress Notes tab, click on the column 
heading by which you wish to sort. 
The column sorts in ascending order. 
 
—OR— 
 
If you wish to sort in descending order and/or by 
multiple criteria, click on the Sort button. 
The Sort Notes window displays. 

 
If at any time, you’d like to 

remove the sorts and/or filters 
you’ve selected, click on the  

Refresh List button. 
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2 Select up to three sort criteria in the three sort fields. Also choose Ascending or 
Descending order by clicking on the corresponding radio button. 

3 Click on the OK button to complete the sort. 
The Progress Notes tab displays with the list sorted. 
 

Within the list of notes, one, several or all of the notes can be selected. To select one note at a 
time, simply click on each note to highlight it. To select all of the notes, click on the Select All 
button. Once a note has been selected, it can be copied, printed, viewed, modified, saved and 
deleted, depending on the status of the note (Draft or Final) and whether or not the worker is the 
Entered By person or the Author. Addenda can also be appended to notes that are in Final 
status. Copying, viewing, modifying and deleting notes can be performed only when one note is 
selected. Once Progress Notes are selected, they will print in chronological order by Entry 
Date. 

Viewing Existing Notes 
Existing notes can be viewed by clicking on the View Existing Notes button on the Progress 
Notes Detail window. The Progress Notes tab displays.  

Once a search of Progress Notes has been conducted (see “Searching Progress Notes” on 
page 20), notes can also be viewed by selecting a note from the search list and clicking on the 
View Note button on the Progress Notes tab. The note displays in view-only mode.  

While viewing the note, the Save as Draft, Save as Final and Cancel buttons are disabled. 
Depending on the worker’s security rights, the Copy Note and New Note buttons may or may 
not be enabled. 

 

Step-by-Step: 
Viewing an Existing Progress Note 

1 From the Progress Notes Detail window, click on the View Existing Notes button. 
The Progress Notes tab displays. 
—OR— 
From the Progress Notes tab, complete the Progress Notes search. 
(See the Step-by-Step instructions on page 20.) 

2 Select the note to be viewed and click on the View Note button. 
The Progress Notes Detail window displays with the contents of the selected note. 

 

Modifying Progress Notes 
Progress Notes can only be modified while in Draft status. Once a note has been saved as 
“Final,” it can no longer be modified; only an addendum may be made. If changes are made to 
the Type of contact, CONNECTIONS will clear all of the worker-recorded data, with the 
exception of the narrative. If Method of Contact is modified, the system will clear all fields 
except the narrative and Type. 
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Step-by-Step: 
Modifying a Progress Note 

1 Select the Draft note to be modified from the Progress Notes tab. 

2 Click on the Edit Note button. 
The Progress Notes Detail window displays with the selected Progress Note. 

3 Make the necessary modifications. Once all of the required fields are recorded, click 
on the Save as Draft button. 
—OR— 
Click on the Save as Final button. 
The Progress Notes tab displays. 
 

Adding an Addendum to a Frozen Note 
To modify notes that are in Final status, addenda are 
necessary. Addenda can only be added to notes in open 
stages. Notes can have multiple addenda. 

Addenda can be added by the Progress Note’s Author, by 
anyone in the Author’s unit hierarchy and by the Progress 
Note’s Entered By person.  

Addenda are added to the bottom of the narrative of the 
original note. The new text is time-stamped with the name and ID of the logged-on worker. All 
previously recorded text in notes and addenda are locked for edit while a new addendum is 
being created. Once the worker starts typing, the View Existing Notes, Copy Note and New 
Note buttons disable. The Save as Final and Cancel buttons enable. 

 

Step-by-Step: 
Recording an Addendum to a Progress Note 

1 From the Progress Notes tab, select a note in Final status. 

2 Click on the Options menu and select Add Addendum. 
The Progress Notes Detail window displays with the selected Progress Note. 
All existing fields and the narrative are locked for edit. 

3 Record text at the bottom of the existing narrative. 

4 Click on the Save as Final button. 
The note is stamped with the time and date and the 
name of the Entered By person. The Progress 
Notes tab displays. 
—OR— 
Click on the Cancel button. 
The Progress Notes tab displays. 

Once an addendum has been added, the Addendum column of the search grid is flagged with 
a “Y,” indicating an addendum exists for the note. If notes do not have addenda, the column is 
flagged with an “N.” 

 
Since supervisors cannot modify 

their workers’ notes, they use 
addenda to modify a note 

completed by their workers. 

 
By clicking on the Cancel 

button, the addendum is not 
added, and the time/date and 
name are not stamped on the 

existing Progress Note. 
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Ease of Use Enhancements 
There are several functions within Progress Notes that can be utilized from both the Progress 
Notes tab and the Progress Notes Detail window.  

Printing Progress Notes 
The saved contents of one Progress Note, a series of notes, or all notes of the Investigation 
stage can be previewed and printed from the Progress Notes tab in the CPRS. The notes print 
as one document, listed in chronological order. 

To print Progress Notes from the Progress Notes tab, select 
the note(s) to be printed, click on the File menu and select 
Print, or simply click on the Print Note(s) button. Once on the 
Print Notes window, the worker must choose either to print the 
data fields with the narrative, or to print the data fields without 
the narrative. Printing only the data fields generates the 
Progress Notes Data Report. Click on the corresponding radio 
button to select the format and then click on the OK button. 
The worker can also choose to cancel the print request by 
clicking on the Cancel button. 

 
To print notes from the Progress Notes Detail window, click on the File menu and select Print. 
Follow the instructions above to complete the printing.  

Below is a sample Progress Notes Data Report. For a sample of a printed Draft Progress Note 
with the narrative included, see “Appendix C: Sample of a Printed Progress Note” on page 31. 

 

 
To select multiple notes, hold 

down the Ctrl key on your 
keyboard and select the desired 

notes. Scroll down the list, if 
necessary, using the scroll bar 
on the right side of the search 

results grid. 
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Copying Progress Notes 
Notes in either “Draft” or “Final” status can be duplicated to one or more other open 
Investigation stages within the same case. The ability to copy notes improves efficiency by 
saving the worker, or any other person with the appropriate security (see security information on 
page 3), from having to record the same information more than once for the same case. A note 
can be copied simultaneously to more than one stage. However, only one note can be copied at 
a time. Copying the note duplicates all of the data fields and the narrative. 

 
In order to copy a note, all of the following must apply: 

• The worker has saved the Progress Note. 

• The Progress Note’s Event Date is on or after the Intake Stage date of the Investigation 
stage to which the note is being copied. 

• The original stage’s District/Agency is the same as the “copied to” stage’s 
District/Agency. 

• The “copied to” stage must be a Build 16 implemented stage. 
 

The Progress Note being copied must support the same level of edit matrix and data values as 
the “copied to” stage. 

• The original note’s Participant(s) or Focus must be part of the “copied to” Investigation 
stage. 

• The Entered By worker or the Author of the original note must be assigned as the 
Primary or Secondary worker of the “copied to” Investigation stage, or be part of the unit 
hierarchy of the worker(s) assigned to the Investigation stage. 
 

System edits will prevent a worker from copying another worker’s note to a different stage. If the 
worker attempts to do so, the following error message will display: 

“No open stages meet the criteria to add a copy of the selected note. 
Cannot copy Progress Note.” 
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Step-by-Step: 
Copying a Progress Note 

1 From the Progress Notes Detail window, click on 
the Copy Note button. 
—OR— 
From the Progress Notes tab, select the note to be 
copied and click on the Copy Note button. 
The Copy Note window displays with a list of 
possible open stages within the case to which you 
have modify rights. 

2 Select the stage(s) you wish to copy the note to by clicking in the check box next to 
each corresponding stage ID.  
The Save button enables. 

3 Click on the Save button. 
The note has been copied to the selected stage(s) 
and displays in Draft status. The “Entry Date” field 
fills with today’s date (the date the note was 
copied). This is also the first day of the 15-calendar-
day “Draft” period. 

4 Click on the OK button.  
The following message displays:  
“Progress Note has been copied.” 

 

Deleting Draft Progress Notes 
The situation may arise when a worker decides it would be more efficient to delete an erroneous 
note, rather than try to modify it. Provided the note is in Draft status, it can be deleted. Workers 
with the ability to modify notes can delete notes. Only one note may be deleted at a time. 
Deleted notes are completely removed from CONNECTIONS and cannot be recovered, i.e., 
there is no historical record of deleted notes. 

 

Step-by-Step: 
Deleting a Progress Note 

1 From the Progress Notes tab, select a note in Draft status. 

2 Click on the Options menu and select Delete Draft Note. 
The following message displays: “Are you sure you want to delete this note?” 

3 Click on the Yes button to delete the note. 
The Progress Notes tab displays and the system refreshes with the deletion of the 
note. 
—OR— 
Click on the No button to retain the note. 

 
The “Entry Date” field fills with 
today’s date (the date the note 
was copied). This is also the 

first day of the 15-calendar-day 
“Draft” period. 

 
Progress Notes that are copied 

do not retain any system 
relation between the original 

version and the copy. In other 
words, modifying one note has 

no effect on the other note. 
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Appendix A: Information to Be Recorded in Progress Notes 

Progress Notes record the caseworker’s investigative, assessment and intervention activities in 
an objective and behaviorally descriptive way which support the caseworker’s conclusions about 
safety, risk, family functioning and the credible evidence that exists or fails to exist to 
substantiate allegations of child abuse and maltreatment. Additional casework activity which 
supports decision making and service planning is to be documented in Progress Notes for 
cases open for services and for cases in which children have been placed in out of home care. 
Progress Notes should be recorded contemporaneously with the event, interview, observation 
or activity to preserve the integrity of the information being recorded. 

Use clear, descriptive, factual information. Impressions or opinions of workers may be included 
and labeled as such. Relevant information that supports the worker’s opinions and impressions 
should be included, wherever possible. Also describe results of the contact, as appropriate, 
including any decisions made, actions planned, next steps or planned follow-up. 

Below is a non-exhaustive list of the key events, activities and contacts that are to be 
documented in Progress Notes. 

• descriptions of all interactions with the child(ren) and parents during the course of the 
investigation and while receiving services, including missed or cancelled appointments;  

• observations of parent and child(ren), family functioning and interactions and household 
conditions; 

• descriptions of collateral contacts relating to the collecting of information needed to 
formulate an assessment and/or assist with making a determination of a CPS report; 

• actions taken in the investigation of a reported case of child abuse or maltreatment; 
including the documentation of all information gathered to support the completion of the 
Safety Assessment, Risk Assessment Profile (RAP), allegation substantiation or 
unsubstantiation and report determination; 

• efforts made to engage the family and child(ren) in the development of the service plan 
and the family and child(ren)’s level or degree of participation in the process and their 
perceptions and reactions  to  the service plan;  

• documentation of family and child(ren)’s participation in services, the need for 
modifications to the service plan based on progress towards goals, and efforts made to 
overcome any barriers to service provision; 

• referrals and communications with service providers involved in the case and information 
received from service providers concerning their contacts and activities with the 
child(ren) and/or family receiving services; 

• descriptions of contacts with educational/vocational personnel on behalf of a child; 

• referrals and communications with probation regarding a child in the case; 

• description of casework contacts with child’s caretakers if child is in foster care or 
alternative placement arrangement; 

• court hearings or other legal activities and their outcome; 

• descriptions of activities related to medical, psychological and dental examinations, 
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including any significant results, diagnosis and referrals arising from these examinations; 

• significant events such as births, marriages, divorces, etc.; 

• documentation of specific safety issues and inadequacy of safety interventions that 
support the need for placing a child(ren) into foster care; 

• the diligent efforts made to maintain the child(ren) in the home prior to placement, and 
alternatives explored to prevent foster care placement; 

• efforts made to prevent moves of child(ren) while in foster care; 

• descriptions of parental and sibling visits with any child who is in foster care, and missed 
visits when this occurs; and any others present during the visit including the caseworker; 

• chronological documentation of diligent efforts, to assist, develop and encourage a 
meaningful relationship between the parents and the child; 

• efforts by parents to make a realistic plan, provide an adequate home and provide 
parental care for the child; 

• efforts made to pursue adoption or another permanency planning goal for the child when 
it is determined that permanency for a child cannot be achieved within the child's own 
family; 

• documentation of caseworker/supervisor conferences, including a description of the 
nature of the discussion and any follow-up activities to occur; 

• documentation that foster parents or prospective foster parents have been asked 
whether they will accept a sibling group, or accept a sibling at a later time, if appropriate; 

• documentation that foster parents have been provided with information on the existence 
and location of all siblings or half-siblings of any child placed with them; 

• documentation that foster parents have been informed that diligent efforts will be made 
to facilitate regular biweekly visitation between the foster child and his or her parents and 
between minor siblings or half-siblings who have been placed apart, unless such contact 
is restricted by court order or in the case of siblings or half siblings, would be contrary to 
the health, safety or welfare of one or more of the children or unless the lack of 
geographic proximity precludes visitation; 

• documentation that the parents were notified at placement of the possible consequences 
if a child were to be in foster care for 15 of the most recent 22 months, discussion with 
parents regarding the deleterious effects of foster care on the child(ren) and the 
child(ren)’s need for permanency; 

• with regard to a child is foster care, documentation of the basis for not filing a 
Termination of Parental Rights for either/both parents as circumstances require; 

• for a child freed for adoption, documentation of efforts to locate an adoptive home for the 
child or secure another permanent resource for children who refuse adoption; and 

• document the reason for the decision to consolidate the subsequent investigation into an 
on-going investigation. (See the CPS Functions Job Aid for guidelines and a full 
explanation of Consolidated Investigations.) 
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Appendix B: Progress Notes Data Fields Edit Matrix 
Ty

pe

M
et

ho
d

Un
an

no
un

ce
d

Pu
rp

os
e

Pa
rti

ci
pa

nt
O

th
er

 P
ar

tic
ip

an
t

Lo
ca

tio
n

Fo
cu

s

Ev
en

t D
at

e
Ev

en
t T

im
e

Au
th

or

Na
rra

tiv
e

Attempted 
Casework
Contact6

Face to Face E E D D E E R E4 R R
Mail E E D D D E R E R R
Fax E E D D D E R E R R

Phone E E D D D E R E4 R R
Email E E D D D E R E R R
Other E E E E E E R E R R

Attempted 
Family 
Visitation

Face to Face D E E E E E R E4 R R

Attempted 
Sibling 
Visitation

Face to Face D E E E E E R E R R

Face to Face D E E E E E R E R R
Phone D E E E D E R E R R
Other D E E E E E R E R R

Face to Face E E R1 R1 R E3 R E4 R R
Mail E E R E D E3 R E R R
Fax E E R E D E3 R E R R

Phone E E R E D E3 R E4 R R
Email E E R E D E3 R E R R
Other E E R E E E3 R E R R

Face to Face D E D R R E R E R R
Mail D E D R D E R E R R
Fax D E D R D E R E R R

Phone D E D R D E R E4 R R
Email D E D R D E R E R R
Other D E D R E E R E R R

Face to Face D E E E E E R E R R
Mail D E E E E E R E R R
Fax D E E E E E R E R R

Phone D E E E E E R E R R
Email D E E E E E R E R R
Other D E E E E E R E R R

Family 
Visitation Face to Face D E R2 E2 R E R E R E

Sibling 
Visitation Face to Face D E R2 E2 R E R E R E

Summary5 D D D D D D E D D R R
Supervisor/
Managerial
Review5

D D E D D D E E D R R

Attempted 
Casework
Contact6

Court

Collateral 
Contact

Casework 
Contact6

Case 
Conference

 

Key:  
R = Required 
E = Enabled 
D = Disabled 

 

If multiple Types are selected, an edit of 
“Enabled” for one selected Type overrides an 
edit of “Disabled” for another selected Type. 

“Required” overrides all other edits. 
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Exceptions to the Rule 
The Edit Matrix table on the previous page provides the circumstances in which each field is 
required, enabled or disabled. There are exceptions to the rule; these are listed below. These 
exceptions are indicated by a footnote in the Edit Matrix table.  

 
Exceptions to the Rule 

Footnote 
Number Type Method Required Field(s) 

1 Casework Contact Face to Face Either Participant or Other Participant 

2 Family Visitation or 
Sibling Visitation 

Face to Face 
(only possibility) 

At least two Participants or one 
Participant and an Other Participant of 

Relative 

3 Casework Contact 
All  

possible  
choices 

Focus (if Foster/Adoptive Parent or 
Congregate Care are selected in the 

Other Participant field) 

Attempted Family 
Visitation 

Face to Face 
(only possibility) Event Time 

Casework Contact 
or 

Attempted 
Casework Contact 

Face to Face 
or 

Phone 
Event Time 

4 

Collateral Contact Phone Event Time 
 

5 Summary and Supervisor/Managerial Review cannot be selected in addition to any other 
Types. 

 
6 Casework Contact cannot be selected in addition to Attempted Casework Contact. 

 
Edit 4 is a higher-level edit, used primarily in New York City when the Primary worker in the 
stage is a member of a district that has requested additional requirements. For example, if a 
worker in New York City recorded a certain type of Progress Note with certain elements, a field 
that might not be required for an Albany County worker (assuming this is a county that is not 
subject to higher-level edits) will highlight in yellow and be required for the NYC caseworker. 

The Primary worker’s district edits and data values take precedence over the Secondary 
worker’s district edits. Therefore, if the Primary worker is in a district that has the standard-level 
edits and data values, and the Secondary worker is in a district that has requested the higher-
level edits and data values (ACS only), the Primary worker’s standard-level edits and data 
values take precedence over the Secondary worker’s district edits, regardless of which district 
has the higher-level edits and data values. If the Primary worker’s district is in ACS, the higher-
level edits and data values take precedence and the Secondary district will have to follow the 
higher-level edits. The higher-level edits will display however, the Secondary district may opt to 
select only the standard-level of values.  
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Appendix C: Sample of a Printed Progress Note 

CONNECTIONS ****WARNING**** 

CHILD PROTECTIVE CONFIDENTIAL INFORMATION 

RECORD SUMMARY AUTHORIZED PERSONNEL ONLY 

 

CASE ID:              20000125   INV STAGE ID:   20000282   WMS#:  0000000000 

CASE NAME:         Bassler, Linda  INV STAGE NAME:  Bassler, Linda  FFAATTAALLIITTYY  RREEPPOORRTT 

STAGE CD:            Q07   INT REPORT DATE:   12/20/1999  HHIIGGHH  PPRRIIOORRIITTYY 

__________________________________________________________________________________________________________________ 

PROGRESS NOTES – Implemented CPRS 

 

* DRAFT * 

 

Event Date:  12/18/02 Event Time:  11:00 AM  Entry Date:  12/20/02 

Author:  XXXXXXXXXXXXXXXXXXXXXXXXX   Entered By:  
XXXXXXXXXXXXXXXXXXXXXXXXX 

Dist.Agy.:  XXX      Note Status:  Draft 

Addendum:  No       

 

Type(s):  Casework Contact, Family Visitation 

Method:  Face to Face  Unannounced Visit 

Location: Parent’s Home   

 

Family Participant/Focus: 

 

Name 

Family 

Participant 

 

Focus 

XXXXXXXXXXXXXXXXXXXXXXXXX Yes No 

XXXXXXXXXXXXXXXXXXXXXXXXX Yes No 

XXXXXXXXXXXXXXXXXXXXXXXXX No Yes 

  

Other Participant(s): Legal, Medical 
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Purpose(s):  Case Planning, Family Planning 

 

Progress Notes Narrative: 

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX 

 
End of Note 

 


